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Disclaimer 

These Workshop Notes (“Manual”) are provided to you 
on your attendance at the Training Workshop 
(“Workshop”) conducted by Pronamics Pty Ltd of Unit 
4, 38 Leonard Crescent, Brendale, Queensland 4500 
(“Pronamics”) at Pronamics’ business premises or 
elsewhere in Australia as agreed to by Pronamics, in 
the use and application of the Pronamics software 
programs described as “Expert Estimation V2014”, 
“Expert Estimation Genesis”, “Expert Estimation 
Express”, “Expert Estimation Excelerate”, “Expert 
Project”, “Expert Project Express” and “Cost to 
Complete” (individually and collectively called 
“Products”). You have enrolled in the Workshop to 
enhance your learning of the application and use of one 
or more of the Products. 

 

Outcomes from the Workshop 

Upon enrolment in, and attendance at, the Workshop, 
you are deemed to acknowledge that: 

 

 

 

Acceptance and Use of the Manual 

Upon acceptance and use of this Manual, you are also 
deemed to acknowledge that: 

 

 

 

 

Copyright Ownership 

This Manual is subject to copyright which is owned by 
Pronamics regardless of whether a copyright warning 
appears on the page or pages of this Manual. This 
Manual is provided to you personally upon your 
attendance at the Workshop and use by any person 
other than the person who attended the Workshop is 
strictly forbidden. It will be considered a breach of 
copyright should you copy, extract, reproduce, transmit, 
transcribe, store in a retrieval system, translate into any 
language or computer language, in any form, medium 
or by any means, electronic, mechanical, magnetic, 
optical or otherwise either in part or in full, without the 
express written permission of Pronamics. 

 

Trademarks 

Trademarks owned by Pronamics are used and appear 
throughout this Manual (“Trademarks”) and these 
Trademarks may not be used, copied, extracted, 
reproduced or re-printed in any format by you without 
the express written permission of Pronamics. 

© 1997 ‐ 2019, Pronamics Pty Ltd 

 



EXPERT PROJECT Getting Started 

© Pronamics Pty Ltd 2019 – Updated 2/12/2019 
• support + 61 7 3481 9626 • training + 61 7 3481 9686 • pronamics.com.au   Page 3 

contents 
contents ............................................................................................................................................................. 3 

introduction ....................................................................................................................................................... 6 

expert project benefits ...................................................................................................................................... 7 

main feature areas ............................................................................................................................................. 8 

general overview ............................................................................................................................................... 9 

costs process .................................................................................................................................................. 11 

actual progress process ................................................................................................................................. 12 

project action list process .............................................................................................................................. 13 

before you install ............................................................................................................................................. 14 

System Requirements .......................................................................................................... 14 

installation ....................................................................................................................................................... 15 

Installation Instructions ......................................................................................................... 15 

Setup .................................................................................................................................... 15 

starting expert project ..................................................................................................................................... 17 

Launching Program .............................................................................................................. 17 

Setup for First Time Use ...................................................................................................... 18 

expert project help .......................................................................................................................................... 19 

Starting Help ........................................................................................................................ 19 

Context Sensitive Help ......................................................................................................... 20 

setting options ................................................................................................................................................. 21 

working with projects ...................................................................................................................................... 22 

Opening an Existing Project ................................................................................................. 22 

Creating a New Project ........................................................................................................ 23 

Project Details ...................................................................................................................... 23 

Contract tab .......................................................................................................................... 24 

Notifications tab .................................................................................................................... 25 

Master Projects tab .............................................................................................................. 26 

Info tab ................................................................................................................................. 27 

Closing a Project .................................................................................................................. 27 

Exiting Expert Project ........................................................................................................... 27 

  



EXPERT PROJECT Getting Started 

    © Pronamics Pty Ltd 2019 – Updated 2/12/2019 
Page 4   • support + 61 7 3481 9626 • training + 61 7 3481 9686 • pronamics.com.au 

 

navigating expert project ................................................................................................................................ 28 

Open Contract Items ............................................................................................................29 

Toolbar Buttons ....................................................................................................................30 

Context Menus .....................................................................................................................31 

Double Clicking .....................................................................................................................32 

importing an expert estimation project.......................................................................................................... 33 

To import data from Expert Estimation .................................................................................33 

contract items .................................................................................................................................................. 34 

Adding a New Contract Item .................................................................................................35 

Importing Items from a Spreadsheet ....................................................................................36 

resource explorer ............................................................................................................................................ 37 

Overview ..............................................................................................................................37 

Viewing Imported Resources ................................................................................................37 

Imported Resource Information ............................................................................................37 

Creating New Resources ......................................................................................................38 

variation items ................................................................................................................................................. 39 

Creating a New Variation ......................................................................................................40 

Preparing a Variation Cost Estimate .....................................................................................41 

cost codes ........................................................................................................................................................ 42 

Adding New Cost Codes ......................................................................................................42 

Allocating Cost Codes ..........................................................................................................42 

resource timesheet .......................................................................................................................................... 43 

Entering Resources ..............................................................................................................43 

cost explorer .................................................................................................................................................... 44 

Changing the Tree View in the Cost Explorer .......................................................................44 

New Cost Record .................................................................................................................45 

recorded progress ........................................................................................................................................... 46 

Recording Actual Progress – Contract Items ........................................................................46 

Entering Progress for a Selected Date .................................................................................47 

progress claims ............................................................................................................................................... 48 

To Create a New Claim: .......................................................................................................49 

  



EXPERT PROJECT Getting Started 

© Pronamics Pty Ltd 2019 – Updated 2/12/2019 
• support + 61 7 3481 9626 • training + 61 7 3481 9686 • pronamics.com.au   Page 5 

analysis tools ................................................................................................................................................... 50 

Forecasting Methods ............................................................................................................ 51 

Creating a New Record Date ............................................................................................... 52 

printing and reporting ..................................................................................................................................... 53 

Printing from any Window .................................................................................................... 53 

Printing Reports ................................................................................................................... 54 

other tools ........................................................................................................................................................ 55 

Standing Orders ................................................................................................................... 55 

Inventory .............................................................................................................................. 55 

Sundry Items ........................................................................................................................ 55 

Calendar ............................................................................................................................... 55 

Tracking ............................................................................................................................... 55 

Information Management System (IMS) ............................................................................... 55 

Contact Explorer .................................................................................................................. 55 

registration ....................................................................................................................................................... 56 

Concurrent User Licenses .................................................................................................... 56 

glossary ............................................................................................................................................................ 57 

expert project training courses ...................................................................................................................... 59 

 

  



EXPERT PROJECT Getting Started 

    © Pronamics Pty Ltd 2019 – Updated 2/12/2019 
Page 6   • support + 61 7 3481 9626 • training + 61 7 3481 9686 • pronamics.com.au 

introduction 
Expert Project is a real time tool that gives you full control of all the financial functions of your project. Expert Project 
gives you instant access to your project’s information when and where you need it. Expert Project also makes sure that 
you are getting paid what you should be and helps to ensure that what you do is costing as little as possible. Expert 
Project was created by project managers and is supported by Pronamics’ 24 hour, 7 day global technical assistance. 

Expert Project’s comprehensive list of features allows it to be used for projects of all levels of complexity. Expert Project 
is fully customisable and enables you to compare your project’s estimated budget against actual costs and to forecast 
your estimate to complete. Expert Project also offers the ability to produce progress claims, estimate variations, record 
extensions of time and has tools for resource, inventory and standing order management. You can perform full earned 
value (C/SPI) analysis, cash flow and detailed cost analysis. Expert Project also contains alert functions for vital actions 
and performance indicator tools showing as much detail as you demand.  

Expert Project will become an invaluable project management tool and is easily integrated throughout your organisation. 
Expert Project contains multi-user network capabilities, the ability to split a project (allowing it to be worked on in 
different locations), plus the ability to copy and paste data both to and from other standard Windows© applications.  

Expert Project contains outstanding reporting functions including: print preview on all reports, 3-dimensional interactive 
graphs and company name and logo fields to add a personal touch. Expert Project generates reports that are clear, 
concise, accurate and professional. 

Expert Project is easy to use and navigate. Our developers have incorporated thoughtful design with intuitive functions 
and a comprehensive interactive help system. This ensures that new users can become familiar with the program 
quickly and easily. Pronamics also runs regular introductory training courses using professional computer training 
facilities. Pronamics provides 24 hour, 7 day product support and regular application updates to our users.  

Expert Project does not require you to purchase any add-on modules. Your purchase includes the complete suite of 
features as standard. All product updates (including new releases) and support for the first 12 months are included in 
your purchase and our ongoing maintenance subscriptions deliver great value.  

Pronamics is proud of the relationship that we share with our customers. These relationships mean that we are 
continually working to upgrade Expert Project in response to feedback from our clients.  

We look forward to working with you. 
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expert project benefits 
Pronamics has been listening to our clients, which means Expert Project contains not only the features that you need, 
but also what you want. Pronamics has developed one of the most comprehensive and easy to use project management 
packages available.  

Below are some of the benefits of Expert Project. On the next page is a summary of the key features of Expert Project. 
Please take some time to review the benefits and features on offer and compare them with your current system. 
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main feature areas 
Below is a list of the main features and their availability to users of Expert Project. 
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general overview 
Expert Project is a real time project financial management system. This Getting Started guide is designed to give you an 
overview of the main features of Expert Project.  

Expert Project allows project managers to manage their project costs from the job site rather than having to wait for cost 
information to be relayed from head office. By having access to this information in real time, you are able to make 
required adjustments far more quickly than is often possible by using traditional accounting systems. 

Expert Project enables you to record daily or periodic resource usage which gives you an instant estimate of the costs 
incurred on the project for that day. By logging the progress for each item, variation and sundry item, the project’s actual 
costs may be compared with the project’s budget for analysis of the project’s performance. 

Expert Project has been designed so that it can work in conjunction with Pronamics’ Expert Estimation software. When 
you first set up a project with Expert Project, all of your tender estimate and budget information can be imported directly 
from Expert Estimation or from standard Windows-based software via the clipboard. You can also directly enter estimate 
and budget data. 
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Once the tender estimate and budget data have been entered, a wide variety of options are available.  
These options include: 
 

Option Description 

Resource Timesheet   The Resource Timesheet allows you to record the actual costs incurred for that day  
(or any other specified period) based on the resources actually used in that period. 

Cost Explorer The Cost Explorer allows you to enter any costs that are additional to those entered  
into the Resource Timesheet (for example, Overhead (indirect) Costs for telephone or 
office rental). The Cost Explorer also allows you to enter a value of costs to date for a 
cost code and reconcile your invoices to confirm your cost records. 

Progress Item, Variation and Sundry Progress is entered periodically so that a comparison can  
be made between your actual and budget costs. This progress may also be used as  
the basis for the quantities to claim in progress claims. 

Variations Variations can be quickly and easily created and estimated by using the Variation 
Explorer window. Expert Project uses the same Cost Estimate window for estimating 
variations as Expert Estimation.  

Progress Claims Expert Project can generate your Progress Claims automatically based on the quantity  
of each contract item actually performed. You can also alter the quantities to be claimed 
(without affecting your progress data) as and when you require. 

Cost to Complete The Cost to Complete for each cost code can be calculated automatically by using one  
of the in-built calculation routines or can be estimated from first principals by using the 
same Cost Estimate window and functionality found in Expert Estimation. 

Budget Performance The Budget Performance window allows users to view project-wide performance. This 
includes Budgeted and Actual costs as well as forecasting information for each cost code. 

Analysis tools Expert Project provides a wealth of analysis tools to assist the project manager’s 
knowledge of how the project is performing at any point in time. Analysis Tools range 
from the Project Status window, which provides an overview of your project’s Key 
Performance Indicators (KPIs), to the Detailed Cost Comparison for analysing how each 
Cost Code is performing. 

The Earned Value Analysis calculation provides Cost/Schedule Performance Index 
information for comparing your project’s Budgeted Cost of Work Scheduled (BCWS), 
Budgeted Cost of Work Performed (BCWP) and Actual Cost of Work Performed (ACWP). 

Extensions of Time Extensions of Time can be quickly and easily created for recording the status of any 
events that affect the project finish date. 

Project Action List The Project Action List helps to ensure that you never miss an important submission date 
by reminding you of impending events. 
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costs process 
The following diagrams show how the various parts of Expert Project interact. Note these are simplified diagrams,  
as most processes within Expert Project interact with each other. 

 

Image 1 – Cost Process Flow 
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actual progress process 

 
Image 2 – Actual Progress Process Flow  
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project action list process 

 
Image 3 – Project Action List Process Flow 
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before you install 
System Requirements  
To function effectively, Expert Project requires a computer with the following specifications: 

 Minimum Recommended 

CPU  1.5 GHz Processor 2.80 GHz Processor or higher 

Memory 2Gb RAM 4Gb RAM 

Supported Operating 
Systems 

Windows 7  
Windows 8  
Windows 8.1 
Windows 10 
Server 2008 R2 
Server 2012 
Server 2016 

Screen Resolution 1024x768 1920x1080 or higher 

Hard Disk Space Installation requires 200Mb Hard Disk Space 

Additional Software Microsoft Excel (for linking of Rates and Defines to Excel and exporting reports  
to Excel format) 

 
 

 
Note: Calculations in Expert Project are completed in a single thread. As such, multicore processors  
will not increase performance within the program. However, additional cores may improve overall system 
performance while using Expert Project. 
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installation 
Installation Instructions 

 

 

 
 

 
Note: If you would like some extra help installing Expert Project, do not hesitate to call Pronamics at any time 
on: 07 3481 9626 (+61 7 3481 9626 international) or send an email to support@pronamics.com.au. 

 

Setup 
The setup for Expert Project will open. 

 

Image 4 – The Expert Project installation window 

 

 

 

 

Image 5 – The Expert Project End User Licence Agreement window  
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Image 6 – The Destination Folder allows users to specify where the program files are saved 

 

 

Image 7 – The Ready to install window will start the installation of the program files 

Once the setup is finished you are then able to start Expert Project.   
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starting expert project 
Launching Program 
The application can be opened from your Windows Desktop by double-clicking on the Expert Project icon. 

  

Expert Project may also be opened from the Start menu. 

By default, no projects will be open at this stage. To commence work, you will need to either open an existing project or 
create a new project. 

A labelled diagram of the main areas of the Expert Project screen is shown below. 
 

 
Image 8 – The Welcome window is shown in front of the basic Expert Project screen. 

 

Column Title Description 

Menu Bar Most commands in Expert Project can be accessed from the menu bar. If a command is 
not in the menu, it could possibly be available from the context menu. 

Toolbar Buttons will appear on the toolbar for the user to gain quick access to some of the 
common windows and operations. 

Status Bar 

Menu Bar 

Ribbon Toolbar 
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Column Title Description 

Taskbar A button will be created for all open windows (apart from popup dialog windows). 
Switching from window to window is as easy as clicking on the appropriate button.  
Note that the Taskbar is an option. The Taskbar can be turned on and off by using the  
Use Taskbar to manage windows option in the General section of the Options window. 

Status Bar The status bar shows a brief description of menu commands when the mouse hovers over 
them. Other copy and paste status messages may also appear. 

Context Menu  
(not shown) 

The context menu is accessed by right-mouse clicking on a particular area of the screen. 
The menu that appears is dependent on which part of the screen was clicked. The context 
menus are very powerful and contain a number of commands which are not available 
anywhere else. 

 

Setup for First Time Use 
After Expert Project starts, you will be asked to enter a License Holder name (this is the name that will appear at  
the footer of your reports). 

Press the OK button once you are satisfied with the settings on this window. 

  

Image 9 –The Setup for First Time Use window allows you to set a username that will be recorded. 

 

 
Note: Help is available for this and any other window in Expert Project by pressing the F1 key. 
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expert project help 
Expert Project’s Help system is extremely comprehensive and is designed to take the place of a user manual.  
The Help system is automatically updated with your regular program updates. You should refer to the Help system 
as a first step for any assistance that you require. 

Starting Help 

To open the Savvy help system, select Help and Context Help. Alternatively click the  button on the toolbar or use 
the keyboard shortcut F1. 

The Expert Project Help window shown in Image  is displayed. 

 

Image 10 –The Savvy Help Window 

 

You can get help for any menu command or directly within the feature you are using. 

The Help system operates as an unrestricted popup window within Expert Project and you can move it to another 
display if you require. The help window will remember the last location that it was opened, allowing you to have a set 
location that the help file will sit while you work within Expert Project. 

Navigating Savvy help within Expert Project is very simple as the window will refresh and display the relevant 
information for the window that you have opened. 
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Context Sensitive Help 

Clicking the  Help icon in a window of Expert Project will take you to Help specifically about the area of the program 
you are currently viewing. Pressing F1 from any location will also open context sensitive help. 

While the Savvy Help window is open changing windows within Expert Project will update the Savvy Help window and 
display the information relevant to that window. 

 
Image 11 –The Savvy Help Window Showing Context Sensitive information.  

  



EXPERT PROJECT Getting Started 

© Pronamics Pty Ltd 2019 – Updated 2/12/2019 
• support + 61 7 3481 9626 • training + 61 7 3481 9686 • pronamics.com.au   Page 21 

setting options 
There are numerous ways to fine-tune Expert Project to suit your own preferences and requirements. 

 

 
Image 12 – The Options window, showing the General Options 

 

 

 
Note: You will be able to use Expert Project with the default settings. This should suit most users. 
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working with projects 
Opening an Existing Project 

 

 
Image 13 – Open an Existing Project 

  

 
Note: Each Expert Project project consists of a magnitude of files. Only the header (PJ2.PJT) file for each 
project is displayed in the Open window. 

Renaming, moving, copying or deleting files from this window will make the project unusable. Only rename, 
move, copy or delete projects using the functions in the File menu under the Project Utilities option. 

 

 

 

When a project is opened, the title bar of Expert Project will display the file name and the buttons on the toolbar 
will change. The diagram on the following page is indicative of the updated screen. 

If enabled, the Project Action List will also open (to check if this option is enabled see File, Options,  
Project Action List).  

 

Image 14 – The Project Action List 
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Creating a New Project 

 

 

Image 15 – New Project: The Project Tab 

 

 
 

 
Note: Do not select an existing project file from this window. Selecting an existing project could overwrite  
the project. 

Enter a new project name in the File name field. 
 

Project Details 
You can set a variety of details for a new project. You can alter these details at any time after the project has  
been created, with the exception of the Master project, which cannot be changed after the project has been created.  
For more information on Master projects see page 27. 

  

The linked image cannot be displayed.  The file may have been moved, renamed, or deleted. Verify that the link points to the correct file and location.
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Contract tab 
The Contract tab allows you to set a Lump Sum, Schedule of Rates or Alliance/Cost Plus contract type. You can also 
enter project durations as well as start and finish dates. 

 
 

Image 16 – New Project: Contract Tab 

You must set the Contract Start, Finish and Anticipated Finish dates. The Original Contract Finish Date is the date by 
which you must finish the contract. The Anticipated Finish Date is your expected finish date, which could be earlier or 
later than your Original Contract Finish Date.  
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Notifications tab 
The values shown on the Notifications tab represent the maximum number of calendar days between when an event 
occurs and when an action is required. The default values for these options can be set in the File, Options window.  

 
 

Image 17 – New Project: Notifications Tab 

 

 
Note: If the ‘Progress claims prepared on day’ option is 0, progress claims will always be submitted on the 
last day of the month. If a number between 1 and 28 is entered, the date entered will be used for progress 
claims. A negative number represents the number of days prior to the end of the month. 

 

  



EXPERT PROJECT Getting Started 

    © Pronamics Pty Ltd 2019 – Updated 2/12/2019 
Page 26   • support + 61 7 3481 9626 • training + 61 7 3481 9686 • pronamics.com.au 

Master Projects tab 
A Master project is a template used for creating a new project. During the project creation process, a copy of the 
template information is copied into this project. The Master project is unaffected by this process. Use Master projects 
if you are working on projects which are quite similar. Any existing project can be used as a Master. 

 
Image 18 – New Project: Master Projects Tab 

 

 
Note: As the new project will be created based on the Master project, the Master project cannot be changed 
once the project has been created. 
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Info tab 
The Info tab contains user defined fields. The labels for these can be defined in the Options window.  

On the Terminology tab, enter the labels for the fields you wish to retain. These fields will apply for all projects.  

The values entered in these fields on the Info tab are stored within each project. 

 

 

 

 

Closing a Project 

 

The project is closed and you are returned to the default Expert Project window.  
 

 
Note: If unsaved information exists, you will be prompted to save before the project is closed. 

 

Exiting Expert Project  

 

If the Prompt before closing Expert Project option in the General tab of the Options window is checked, you may be 
prompted to confirm that you want to quit Expert Project. 

 
Image 19 – Prompt that will appear when closing Expert Project 
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navigating expert project  
The information in Expert Project is divided up into a number of main areas. These areas are also called  
Windows. The most important windows are found on the Toolbar and in the View menu. Open a project with  
the  Open Project icon. 

The project has opened when the title bar states the name of the project, and the toolbar now displays the full set 
of buttons, as shown in the diagram below. 

 
Image 20 – The workflow window 

 

 
Note: Expert Project allows you to have multiple windows open within the project. 
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Open Contract Items 

 

The Contract Items window will open, as shown in the following diagram. 

 
Image 21 – The Contract Items window 

 

The Resource Explorer window will open on top of the Contract Items window. 

To get back to the Contract Items window, do not press the button again. Each time you press a button, a new copy of 
that window will open. Go to the Window menu and select the window you want to return to.  
 

 
Note: Double-clicking a button from the toolbar will open two copies of the window, one of which will  
be ‘locked’ disallowing any edits. To prevent this occurring, refrain from double-clicking on any button. 
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Toolbar Buttons 
Common commands can be found on buttons on the toolbar at the top of the Expert Project window. The buttons which 
will appear on the main toolbar include: 
 

 Creates a new project  Progress Claim 

 Opens an existing project  Cost Explorer 

 Closes the current project  Resource Timesheet 

 Prints reports  Resources 

 Options window  Cost Codes 

 Finds text in the project  Extension of Time 

 Contract Items  Information Management System 

 Overhead Items  Project Action List 

 Variation Explorer  Project Properties 

 Sundry Item Explorer  Images 

 Contract Items Progress  Project Budget Performance 

 Overhead Items Progress  Calendar 

 Variation Items Progress  Cash Flow 

 Sundry Items Progress  Resource Flow 

   Help 
 

Buttons which are dimmed (greyed out) are unavailable at that time. Most windows have their own buttons at the top of 
each window. These are only available when that window has focus. Buttons on individual windows function specifically 
for that window. For example, clicking on the  Print icon in a window will print the report specific to that window. 
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Context Menus 
Many commands in Expert Project are found in Context menus. Context menus are 
accessed by pointing the mouse cursor over the line or column of text you want to 
work with and clicking once on the right mouse button. 

The commands that appear are valid for the particular area you are working in. 
By using Context menus, you do not have to remember where a command is on 
a menu, as it is right at your fingertips. 

 Select View, Contract Items or click the  Contract Items icon. 

 Right-click on an item in the Description column. 

The Context menu for this column appears, as shown at right. 

The commands shown here are only valid for this column. If you right-click on 
another column, you will see different menu options. 

To select a command from a Context menu:  

 Move the mouse over the command. 

 Click the left mouse button once to select the command. 

To deselect (turn off) the menu: 

 To avoid activating any commands, left-click the mouse somewhere away from 
the menu. The menu will disappear. 

 

 

 

 

 

 

 

 
 

 
Note: Many common commands accessed from the right-click menu also have keyboard shortcuts 
associated with them. These shortcuts are shown to the right of the command on the menu. 

For example, from the Resource Timesheet window, pressing Ctrl and C will copy the current line.  

F2 lists from the currently selected cell. 
 

 

  

Image 22 – Context Menu of Contract Items 
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Double Clicking 
Double-clicking on any cell of information in any window will allow you to either: 

Edit data 

 
Image 23 – Contract Items window 

Or open a child window, such as a Cost Estimate window. 

 
Image 24 – Contract Items with Cost Estimates 

 

 
Note: If double-clicking has no effect, you are either unable to edit data from that area or no child 
windows exist. 
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importing an expert estimation project  
If the tender for your project was prepared in Expert Estimation, the relevant data required by Expert Project can be 
imported from the Expert Estimation project files. 

If you did not prepare the tender in Expert Estimation, then the relevant data can either be copied from another Windows 
application or entered manually. 

To import data from Expert Estimation 

 

 
Image 25 – Importing Data from Expert Estimation 

 

 
 

 
Note: For more information on importing a project into Expert Project or for information on the elements that 
have been imported, refer to Expert Project’s Help system. 
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contract items 
The Contract Items window is a starting point for listing items which directly contribute to the project. 

The actual estimate for each item is available through the Cost Estimate window. 
 

 
Note: Once the project is imported into Expert Project the Cost Estimates can no longer be edited. 

 

From the View menu, select Items, Contract Items or press the  icon on the toolbar. 

 
Image 26 – Contract Items Window 
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Adding a New Contract Item 
You can import items into the Contract Items window, or type them all as new. 

Select the line into which you want to enter text. Alternatively, press the Down Arrow key to add a line  
or F3 to insert a line. 

While entering the information for a new Contract item, several warnings could be raised. 

After typing a Tender Quantity and pressing Enter, a warning box will appear. 

  
Image 27 –Tender Quantity Warning 

After entering the Tender Rate, a warning box will appear.  

 
Image 28 – Tender Rate Warning 
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Importing Items from a Spreadsheet 
You are able to import your Contract items from a spreadsheet. This will save you valuable data entry time and will help 
minimise errors. 
 

 
Note: The columns in your spreadsheet do not have to match exactly to those in Expert Project. 

 

 

 

 

 The Paste Special window will appear similar to the image below. 

 

Image 29 – Paste Special Window 

 Before pasting, you need to tell Expert Project which columns to paste the data into. 

 

 

 The column heading for the second column will change to Item Number. 

 

 

 
Note: Columns that are not labelled will not be imported. 
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resource explorer 
Overview 
The resources listed in the Resource Explorer window include all Group (G), Labour (L), Material (M), Plant (P) and 
Subcontract (S) resources that are available for the project. Resources are used to enter actual costs and to calculate 
the Cost to Complete, as well as to estimate Variations and Sundry items. 

The Resource Explorer is a window that allows you to enter and manage the resources that you have available. The 
data in the Resource Explorer can also be imported from Expert Estimation. You are also able to add new resources 
and make changes to the imported data. 

Viewing Imported Resources 
Expert Project’s Resource Explorer operates in a similar manner to Expert Estimation’s Resource Explorer. However, 
unlike Expert Estimation, in Expert Project the rates can be modified with each use of the resource.  

For example, a plant item costs $100.00 per hour for a weekday and $150.00 per hour on weekends. When the 
resource is used, the data entry can show the relevant rate just for that particular usage. The figure is not changed in the 
Resource Explorer as it is a default rate.  

If you have used Expert Estimation you will be familiar with Base and Group resources. Group resources created in 
Expert Project do not have a Cost Estimate attached. By default, the Labour, Material, Plant and Subcontract 
components of the Group resource will be one quarter of the Group resource rate entered but these can be altered by 
the user. For imported Group resources, the Group’s individual Base components are calculated and imported, thus 
providing the proper break up of Labour, Material, Plant and Subcontract. The Cost Estimates for Group resources are 
not imported from Expert Estimation. 

Imported Resource Information 

 

 
Image 30 – The Resource Explorer Window 

The Buy rate is imported from the Calculated rate in Expert Estimation. The Sell rate needs to be entered by the user.  
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Creating New Resources 
To add a new resource to the Resource Explorer: 

 

 

 The New Resource window is displayed. 

 
Image 31 – New Resource: Detail Tab 
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variation items 
Variations can (and do) occur during a project’s lifetime. Variations usually involve changes to the original quantity 
and/or scope of project works – possibly more or less work, resources, cost and time. Standard project management 
involves a procedure of submissions to the client, with timeframes explicitly defined in the contract. At times, the rate for 
work to be done under the Variation is an unknown value at the time of identification. 

Expert Project allows you to track all stages of the variation process, from first identifying the variation, through 
submission, to acceptance (or rejection) and claiming. The Variation Explorer displays all variations as well as their 
current status.  

Variations must have one of the following statuses: 

Identified Items identified but not yet submitted to the principal. 

Submitted Items either submitted or submitted and claimed to the client but  
have not yet been approved. 

Submitted and claimed 

Approved Items that the client has approved. 

Disputed Items that have been submitted but are being disputed between the parties. 

Not pursued Items that are no longer being pursued with the client. 

  



EXPERT PROJECT Getting Started 

    © Pronamics Pty Ltd 2019 – Updated 2/12/2019 
Page 40   • support + 61 7 3481 9626 • training + 61 7 3481 9686 • pronamics.com.au 

Creating a New Variation 
When a Variation is identified it should be entered into Expert Project immediately. 

 

The Variation Explorer window is displayed. 

 
Image 32 – The Variation Explorer Window 

 

 
Image 33 – Variation Properties: Details Tab 

 

 

 

 The item now appears in Variation Explorer under the identified branch. Identified Variations appear in blue. 
 

 
Note: Variation Submission Number and Submission Date will only become applicable when the status is 
set to Submitted. 
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Preparing a Variation Cost Estimate 
To assist in development of the costs of a Variation, a Cost Estimate for the Variation needs to be completed. 

 

 

An empty Cost Estimate window is displayed. 

 
Image 34 – Cost Estimate for a variation 

 

 

 

You have now developed the budgeted cost of your Variation item. A Direct Cost rate will now appear against 
this Variation. 
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cost codes 
Cost Codes are initially imported from Expert Estimation with corresponding values against them for the works in the 
original tender. These then become the Tender Values with Contract Values being determined as the project 
progresses. Cost Codes window can be accessed from the View menu. 

 
Image 35 – The Cost Codes Window 

 

 
Note: The imported data is from Expert Estimation. If you are not importing from Expert Estimation,  
you will need to enter your Cost Codes manually. 

 

Adding New Cost Codes 

 

 

 
 

 
Note: The unit and quantity fields are not mandatory and are only applicable if the Cost Code is  
distinctly measurable. 

 

Allocating Cost Codes 
You will need to allocate your new Cost Code to an item to populate values in the Tender and Contract fields for 
this Cost Code. 

 
 

 
Note: Cost Codes can be allocated to any type of item (Overhead Costs, Variations and Sundry Items)  
in the same way. 

 

 

 

 

 The Cost Code is added to the Cost Code window. 
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resource timesheet 
The Resource Timesheet allows entry of your project’s periodic resource usage. Timesheets can be prepared daily, 
weekly or for any other period. The cost record entries created from the Timesheet generates your project’s Actual Cost 
of Work Performed (ACWP).  

 

 
Image 36 – The Resource Timesheets Window 

 

 

 
Note: Not all columns are visible. Use the scroll bar at the bottom of the window to view unseen columns. 
The columns in this view can also be rearranged. These settings will be saved for your next session. 

 

Entering Resources 
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cost explorer 
The Cost Explorer shows all cost records entered via the Resource Timesheet or directly entered into the 
Cost Explorer. By the conclusion of the project, this window can contain thousands of entries per project.  
There are many ways to sort and filter these records. 

From the View menu, select Costs, Cost Explorer or press the  icon on the toolbar. 

 

Image 37 – The Cost Explorer Window 

The left pane can be configured to display Cost Codes, Suppliers, Voucher numbers, Resources, Dates or Work 
Area references.  

The right pane displays all cost records related to the selected category or type, from the left pane. 

Changing the Tree View in the Cost Explorer 

 

 

 
Image 38 – The Context menu in the tree view of the Cost Explorer allows you to sort the branches in various ways 

The branches change according to your selection. This allows faster sorting of cost records.  
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New Cost Record 
You can create a new cost record if you have a cost that is not directly related to a work activity, such as a phone bill 
that has arrived and needs to be paid. 

 

 

 

 
Image 39 – New Cost Records: Costs Tab 

 

Existing Cost Records can be edited individually or modified as a group. They can also be cloned. The records in the 
explorer can be sorted (by clicking on a column heading) or filtered (by choosing Select Cost Record Subset from the 
right click menu), to easily identify and edit individual entries. 
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recorded progress 
The Recorded Progress area of Expert Project allows you to enter the quantity of work performed for each item. This 
enables calculation of the Budgeted Cost of Work Performed (BCWP). 

When you record progress against an item, it multiplies the Quantity entered by the Estimated Cost Rate for the item to 
calculate your BCWP. The budgeted cost of work performed is compared with your actual costs in Expert Project’s 
analysis windows. 

The quantities that you enter into progress can also be used as a starting point for the quantities that you wish to claim 
in Progress Claims. 

Actual progress is entered against Contract, Overhead, Variation or Sundry Items. 

Recording Actual Progress – Contract Items 

 

 
Image 40 – Date Selection for Progress Record 

You will be progressing up to and including the date that you specify. It will record progress from the last progress date 
recorded.  

 

 

The Contract Items Progress Period Ending window appears as shown in the diagram on the following page. 

 
Image 41 – Contract Item Progress Period Ending Window 

 

 
Note: Only the Item Number, Description, Unit, Quantity at Completion, Quantity this Period and Quantity to 
Date columns can be modified from this window. 
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Entering Progress for a Selected Date 

 

 

Alternatively you can enter the Quantity to Date. 
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progress claims 
The Progress Claim feature of Expert Project allows you to create claims to the client for your project. You should 
prepare a claim when progress has been recorded and you need to be paid by the client. 

Quantities to claim may be entered either automatically (based on your recorded progress) or manually. Progress claims 
are created from the Progress Claim Summary window. 

From the View menu, select Income, Claim or press the  icon on the toolbar. 

 
Image 42 – Progress Claim Summary 

The Progress Claim Summary window shows previous claim details and any attached notes. Previous claims can be 
modified, however if they have already been submitted, warnings will be displayed.  
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To Create a New Claim: 

 

The New Claim window will be displayed. 

 
Image 43 – New Claim Window 

On the New Claim window: 

Claim ID The ID may be any text, number or date to identify the claim.  

Base date The date up to which you want to claim progress. 

Use progress to date as  
basis of claim 

When checked, generates the claim using the quantities of each item entered  
in the actual progress since the last claim. 

Select items for which  
progress is to be included 

If the Use progress to date box is checked, you will also be able to select  
individual items that will appear in this claim. 

 

 

 
 

 
Note: Dates cannot be entered earlier than previous claim dates. 

 

 

 

 

 

  
Image 44 – Contract Item Progress Period Ending Window   
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analysis tools 
The Analysis menu contains windows displaying analytical data which can be viewed or printed at any stage of the 
project. Some Analysis windows can be customised and graphed. 

The Budget Performance window is used for analysing your project’s Cost Code performance and calculating the Cost 
to Complete. This can be done at any time during the project. 

The Budget Performance window will display your historic Cost Code performance which can be used as the basis for 
predicting your future performance. Alternatively, a Cost to Complete may be produced using first principles estimates. 

 

 

 

 
Image 45 – Budget Performance: Summary Tab 

The Baseline estimate is your budget performance at the start of the project. The Statement build date for the Baseline 
estimate is the first date of your project. 
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Forecasting Methods 
Forecasting allows the user to create a ‘picture’ of the project at completion.  

Forecasting in the project Budget Performance window allows you to produce a Cost Estimate or use predefined 
methods of determining the Cost to Complete for each cost code for the project. You can only perform Forecasting 
on defined record dates.  

The Detail tab of the project Budget Performance window allows you to prepare and view your Cost to Complete. 

 
Image 46 – Budget Performance: Detail Tab 
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Creating a New Record Date 

 

 
Image 47 – The Create New Record Date Window 

 

 

 

 
 

 
Note: For more information on the forecasting formula consult the Expert Project Help system by pressing 
F1 from the Detail tab of the Project Budget Performance window. 

See page 36 for more information on using the Expert Project Cost Estimate window. 
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printing and reporting 
You can preview or print any window in Expert Project. Before you start, configure your printer through the File menu, 
Printer Setup command. 

Printing from any Window 
Depending on the window you wish to print from, there are two main ways to print reports from windows in  
Expert Project. 

If the window is a grid (spreadsheet) style window:  

This will include windows such as the Contract Items, Variation Items, Resource Explorer and Cost Explorer windows. 

 

To preview the report first: 

 

 

A preview of the report will appear. 

 
Image 48 – The Project Status Report 

 

To print a form style window: 

This could include windows such as the Resource Details, Cost Record Properties or Resource Properties windows. 
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Printing Reports 
Reports can also be printed from the Print Reports window. 

The window below shows the reports available. Refer to the Expert Project Help system (Press F1) for more information 
about each report. 

 

The Print Reports window is displayed. 

 
Image 49 – The Print Reports Window 

 

The selected reports appear in the lower pane. Double-clicking a report in the lower pane removes the report from the 
Selected reports list. 
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other tools 
Standing Orders 
The Standing Orders window is used to record orders for resources where a quantity of resources is ordered but will 
not be supplied in one lot. For example, you may have a standing order for 500m³ of concrete to be supplied over the 
duration of the project. 

Inventory 
The Inventory window is used for recording and viewing inventory resource purchases and withdrawals.  

Sundry Items 
Sundry items (sometimes called Works Orders) are items of work that are not included in the project’s Contract items. 
Sundry items may be generated by the client (and claimed using the normal Progress Claim window) or may be non-
client generated (and claimed using the Non-client Sundry Progress Claim window).  

The Sundry Items Explorer has two view modes: Sundry Item Summary mode and Sundry Item Element mode.  

Calendar 
The Calendar window allows you to easily navigate to particular events or entries on a particular date. The calendar  
also allows you to define non-work days. 

Tracking 
The Tracking window allows you to track key performance indicators for the actual value of costs and production for a 
portion of work and compare them with target budget costs and production. 

Information Management System (IMS) 
The Information Management Explorer window is used to record and view all information flow for the project.  
Both incoming and outgoing information may be recorded. 

Contact Explorer 
The Contact Explorer window is used to view, edit and create contacts for use within the Information Management 
Explorer (IMS) window or as a stand-alone contact manager. 
 

 
Note: For information on these functions or any other area of Expert Project, please consult the Expert 
Project Help file or contact the support staff at Pronamics. 
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registration 
For Expert Project to function fully (without system limitations), the program must be registered. 

To assist your evaluation, Pronamics offers a free trial registration allowing Expert Project to be used without limitations 
on actual projects for a period of 30 days. Please contact Pronamics if you would like to obtain a temporary registration. 

After purchasing Expert Project, your copy can be permanently registered using the procedure outlined below. 

To access the Expert Project Registration window, select File, Registration, Register Expert Project. The following 
window is displayed: 

  
Image 50 – The Expert Project Registration Screen 

The License information number is unique to your computer. We will ask for this information when you call and 
in return, provide you with an Unlock code to register the product. The Server based license file is used if this 
is a concurrent user registration. 

To register Expert Project, please have the program open at the above window and telephone Pronamics on  
(07) 3481 9626 or +61 7 3481 9626.  

Registration via facsimile and e-mail can be processed if required. Please contact Pronamics technical support 
for details. 

Concurrent User Licenses 

Where a server based licence is required, a suitable folder is created on the server and all users are given read and 
write permissions to the folder. It will be used to hold the licence file. The software is installed on the local computers as 
described in the Installation section of this manual. The computers will be connected to the server based licence file 
during the registration process. 
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glossary 
 

Accrued A cost record for which the actual cost to the project is not known. 

Backup The process of saving a copy of the project information to guard against errors that 
could make the current project unusable. 

Base resource An identifiable, physical item that has a cost and can be assigned to a work item. 
Expert Project has four groups of Base resources: Plant, Labour, Material and 
Subcontract. 

Cash Flow A representation of the incoming and outgoing monies derived from the project. 

Claim A type of invoice to the client for work completed. 

Confirmed A cost record for which the actual cost to the project is known. 

Contract items The list of work items provided by the client or created by the tenderer. 

Cost Estimate A method of systematically creating an estimate for a variation, cost to complete or 
sundry item. 

Cost Code A budget group used to prepare a budget for construction after a project is won  
and awarded. 

Cost record An individual cost to the project. 

Cost to Date The total for all costs for a cost code or project. 

Current project The project that is currently open in Expert Project. 

Direct Cost schedule The schedule which makes up the direct project work elements. 

Extensions of Time Changes to the contract completion date due to events associated with the project. 

Group resource An identifiable, physical work process that can be costed and assigned to a work 
item as a process. Group resources are of limited use in Expert Project. 

Holiday A day defined in the program as a non-workday. 

Information Management 
system 

Also known as IMS - a module designed to manage all information flows on the 
project. 

Item note A document used by Expert Project to display notes made by the Estimator 
concerning the item to which the Item note is attached. 

Margin The amount of money added for profit or contingencies to a project’s estimated cost. 

Master project A project especially created for the purpose of being used as a template for a 
specific work type. 

Open project The project which is being managed at this time. 

Overhead items The schedule which makes up the indirect project work elements. 
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Payment lag The duration between the use of a resource and the payment for the resource. 

Profit See Margin. 

Progress Recording the actual amount of work completed. This is used to generate the 
budgets to compare to actual costs. 

Project Action list A list of actions required for the project. Submitting of variations and extensions of 
time, progress claim approval and payment and information management system 
document actions as detailed in the Project Action List. 

Project notes A document used by Expert Project to display notes made by the Estimator 
concerning the project as a whole. 

Rate Only An item that requires a rate to be submitted as part of the project submission.  

Resource A physical item which has a cost for consumption and can be assigned to a cost 
item. See also, Base resource. 

Resource Flow The representation of the use of a resource over the duration of the project. 

Resource Timesheet A form to record costs recorded against a project in a given period. 

Resource Usage The total number of units of a resource used in a project. 

Sundries An area to enter works performed for other parties during the course of the project. 
Also known as Works Orders. 

Tracking A module to allow the tracking and reporting of costs and budget on specific work 
activities. 

Variations Changes to the defined works. 

Work item A Direct or Overhead Cost item, which represents a section of the project that has 
definable scope. 

Works Orders See Sundries. 

Unit The means by which the resource is measured. 
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expert project training courses 
Pronamics offers a self-paced introductory online training course providing foundation skills to ensure users get the most 
out of their software. Each purchased Expert Project licence includes one seat for online introductory training.  

In addition Pronamics also offers in-house training solutions, allowing users to participate in face-to-face training, 
customise course content and ustilise their own projects as course case studies.  

Please contact Pronamics for any further information on +61 7 3481 9686 or at training@pronamics.com.au 
 

Introductory Expert Project Face-to-Face Training – Course Outline 

Lesson 1 Introduction 

 
 
 
 
 
 

Lesson 2 Navigating Expert Project 

 
 
 
 

Lesson 3 Using Expert Project Help  

 
 
 
 
 
 
 
 
 

Lesson 4 Starting a New Project  
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Introductory Expert Project Face-to-Face Training – Course Outline 

Lesson 5 Contract Items  

 
 
 
 
 
 

Lesson 6 Overhead Items  

 
Lesson 7 Resource Explorer 

 
 
 
 

Lesson 8 Variation Explorer 

 
 
 
 
 
 
 

Lesson 9 Cost Codes  

 
 
 
 

Lesson 10 Resource Timesheet  
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Introductory Expert Project Face-to-Face Training – Course Outline 

Lesson 11 Cost Explorer  

 
 
 
 
 
 
 
 
 
 
 

Lesson 12 Recorded Progress 

 
 
 
 
 
 
 
 

Lesson 13 Progress Claims 

 
 
 
 
 

Lesson 14 Extension Of Time 

 
 

Lesson 15 Project Action List 

 



EXPERT PROJECT Getting Started 

    © Pronamics Pty Ltd 2019 – Updated 2/12/2019 
Page 62   • support + 61 7 3481 9626 • training + 61 7 3481 9686 • pronamics.com.au 

Introductory Expert Project Face-to-Face Training – Course Outline 

Lesson 16 Budget Performance 

 
 
 
 
 
 
 
 

Lesson 17 Analysis Windows 

 
 
 
 
 

Lesson 18 Printing and Reporting 
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